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1 Syfte

Denna laboration &r en introduktion till Androidprogrammering for att ni ska ha méjlighet att gora
en mobilapp som projekt. Ni kommer dven att fa en introduktion till hur man anvénder enklaste
mojliga databas tillsammans med Android, det mojliggor applikationer med mer avancerade data!

2 Inledning

Uppgiften ar att gora en “Att gora-lista” med mojlighet att lagga till och ta bort uppgifter.

3 Utvecklingsmiljo

Vi anviander Android Studio fér labben. For att 6ppna programmet, hitta fram till och kor filen
“S:\\Android\a_ studio\Android\ Android Studio\bin\studio64.exe”.

Nér du 6ppnar Android Studio fragar hen vad du vill géra. V&lj att skapa ett nytt projekt, och
dop det till nagot, till exempel “Awesome freakin todo-list”, eller nagot béttre namn. I rutan for
“Project Location” véljer du vart du vill spara dina filer. Vi foreslar att du véljer en mapp som
finns pa “privat_stuff”, vi kommer att anvinda “H:/Workspace”. Klicka pa next, och vilj att du
vill skapa en app for “Phone & Tablet” med “API 19: Android 4.4” eller hogre som “Minimum
SDK”. Vilj sedan att du vill ha en “Blank Activity”, och ge den namnet “MainActivity”.

3.1 Skapa en Androidemulator

For att kunna kora en Androidapplikation beh6évs en Androidenhet. Eftersom vi inte utgar fran att
alla har en Androidtelefon/-platta foreslar vi att installera en Androidemulator. “Tools -> Android
-> Android Virtual Device Manager / AVD Manager”, vilj sedan “Create...”. Forslagsvis:

AVD Name: MyDevice

Device: Nexus 5

Target: Android 4.4 - API Level 21

Emulating Options: Use host GPU

Lamna resten som default.

Om atminstone upp till API 19 inte finns i listan dar target API viljs sa behover du installera det.
Gor det genom att kryssa rutan som dok upp nér du valde att skapa en ny enhet och krysssa sedan
ocksd AVD Manager. Ga sedan i menyn till Android Studio “Tools -> Android -> SDK Manager”,
kryssa exempelvis API 19 i listan (vénta en liten stund om den inte dyker upp direkt) och klicka
sedan p& installera-knappen. Nu ska du kunna skapa din enhet med ratt installningar!

Kor din Androidapplikation genom att trycka pa “Play” knappen i menyn eller Shift+F10, och
kryssa sedan i “Launch emulator” och vilj “MyDevice” som du skapade tidigare. Notera att
Androidemulatorn tar ndgra minuter att starta forsta gdngen. Sting inte av emulatorn med krysset
mellan korningar for da tar det lang tid att starta varje gang.



4 Todo-app

Den hér labben gar inte in pa ett avancerat djup i hur Android fungerar. Fokus kommer vara att
arbeta i Java och nédvéindiga Androidspecifika komponenter kommer att beskrivas nedan.
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Figure 1: Exempel pa hur en fardig ToDo-app kan se ut.

4.1 Debug prints

For den som ar van att arbeta med textbaserade program &r det vanligt att géra “debug prints” -
utskrivningar i till exempel en konsoll - for att kontrollera att varden i variabler ar korrekta eller
se att funktioner blivit anropade etc.

Android Logcat, dar loggarna du gor syns, ska starta samtidigt som du startar din emulerade tele-



fon. En utskrift i LogCat gors genom att forst ge ett meddelande en tagg som identifierar dess typ.
Exempelvis “databas”, “info” eller “debug”. Vi kommer anvéinda taggen “TodolLog”. Nar LogCat &r
oppnad behéver vi skapa ett filter, for Android kommer att spotta ut véldigt mycket meddelanden

och vi ar just nu enbart intresserade av “TodoLog”.

Klicka pa rullgardinsmenyn till hoger déar det star nagot i stil med “app: com.example.lithehack.mytodolist”,
och vilj sedan “Edit Filter Configuration”. Tryck sedan pa plus-tecknet i fonstret som dyker upp,

for att inte skriva 6ver existerande filter. Ge ditt filter ett lampligt namn, och i rutan “by Log Tag
(regex)” skriver du sedan “TodoLog”. Klicka pa OK, och i samma rullgardinsmeny som tidigare,

valj ditt nyskapade filter.

Testa att det fungerar genom att logga i funktionen onCreate.
Log.d("TodoLog", "Programmet startat");

Android Studio vet inte automatiskt vad en Log &r och markerar ut ett error. Importera klassen
genom att klicka pa den réoda lampan som dyker upp vid sidan om och valj “Import class”. Alter-
nativt kan markéren stéllas i det rédmarkerade Log sa att man kan trycka Alt+Enter for att fa
upp samma meny.

En annan bra grej man kan vilja ha ndr man far errors ar radnummer i kodeditorn. Vad bra att
de ar avstdngda fran borjan och att installningen finns begravd i massa menyer. I Android Studio
1.0.1 finns instéllningen i File -> Settings, under IDE Settings: Editor -> Appearance.

4.2 Visa en lista

For att kunna skapa en lista med saker att gora ar det lampligt att forst skapa den grafiska layouten
for listan. Det grafiska grianssnittet ligger i filen “res / layout / activity_main.aml”.

Filen bor ha 6ppnats nar du skapade ditt nya projekt. Om den inte gjorde det, leta upp den i
“Project”-vyn och dubbelklicka péa den.

Antingen far du nu upp det grafiska granssnittet for att redigera en vy, eller sa far du upp det
text-baserade granssnittet. Oavsett vilket &r det gott si, det finns en podng med att vara bekant
med bada. For att vixla mellan de tva vyerna kan du byta flik med alternativen nere till vinster
om vyn: “Design” och “Text”. I det som kallas “Design” kan du direkt redigera grénssnittet genom
att dra in olika element ifran “Palette” och i det som kallas “Text” redigera XML-koden.

Textfaltet “Hello World!” kan du bara ta bort genom att antingen markera det direkt eller markera
det i listan “Component Tree” till hoger, och trycka pa delete.

Skapa en lista genom att dra in elementet “ Container -> List View”. For att varan aktivitet i appen
ska kunna na listan sd maste den fa ett lite annorlunda “id” dn vad den har nu. I “XML-vyn”
finns det en rad som specifierar “android:id”. Andra virdet i det till “@android-id/list”. Dvs, i
ListView-blocket ska det finnas ett attribut android:id med vérdet “@android:id/list”. Detta &r
olyckligtvis lite speciellt nér det kommer till just en lista och vi kommer senare att behandla id pa
ett mer konventionellt sitt nir det kommer till knappar och textfalt.

Nu kan du aterga till koden i filen MainActivity.java, som innehéller kdllkoden fér huvudaktiviteten
i din app. D& vi har valt att skapa en lista i var Activity, sa gor vi bést i att arva fran ListActiv-



ity istéllet for Activity eller ActionBarActivity i var klass. Andra si att MainActivity drver ifran
ListActivity istéllet for Activity.

Notera att pa samma satt som med Log behover ListActivity importeras.

For att gora en enkel lista att testa ditt grafiska griansnitt med, sa behovs det lite data att visa.
Ge din klass en privat datamedlem som &r en ArrayList av typen String och dép den till testData.
ArrayList ar i syntaxen ganska lik Vector, som du kanske &r bekant med sedan tidigare. Deklarera
dven en privat datamedlem av klassen ArrayAdapter som tar typen String och dép den till adapter.

I metoden onCreate, som anropas direkt efter appen har startats, kan du instansiera din String
ArrayList med lite testdata. Har gér du som du vill, ett sidtt ar loopa igenom arrayen och lagga in
en siffra eller textsnutt for varje index. For att se metoderna till en klass, Googla eller se klassens
implementation genom att halla ner kontroll och klicka pa den i editorn.

Nu maéste vi koppla denna data till vart grafiska grénssnitt. Detta &ar inte helt intuitivt till en
boérjan, sa ni far lite hjalp med det:

adapter = new ArrayAdapter<String>(this, android.R.layout.simple_list_item_1 , testData);
setListAdapter (adapter) ;

Det som sker har ar att vi skapar en s.k ArrayAdapter som kopplar ihop datan som &r lagrad i
testData med det grafiska gransnittet. Vi anger vilken datatyp det dr (String) och var datan &r
lagrad (testData). Tillslut tilldelar vi adaptern till aktiviteten via setListAdapter.

Om allt har géatt ratt till s& bor nu appen kunna startas genom att trycka pa Run. Appen bor
startas i Android emulatorn. En lista, som forvisso ar ratt trakig och statisk, bér nu visas!

Uppgift: Gor en lista i det grafiska grénssnittet. Skapa en ArrayList av typen String, initialisera
den med lite data och koppla ihop den med en ArrayAdapter, ocksd av typen String.

4.3 Interagera (click event) med en lista

Nu ar det dags att fa igang interaktionen med listan. Eftersom var MainActivity arver av ListAc-
tivity, sa ar det ganska enkelt att komma igang med.

For att skapa en event listener som lyssnar pa interaktioner med listan ska vi 6verlagra meto-
den onListltemClick fran ListActivity. Har kan vi anvinda Android Studio fér att generera en
metodsignatur. Stall markéren nagonstans i klassen MainActivity (men inte i ndgon metod), borja
skriva “onListltemClick” och tryck ctrl4+space. Android Studio foreslar da att infoga en Gverla-
grad variant av onListltemClick fran ListActivity med alla funktionsparametrar som behévs. Magic!

OBS! Notera att du behéver dndra sa att de tva sista argumenten &r konstanta, dvs final int re-
spektive final long. Detta behovs senare for att ha tillgdng till dem i en lyssnare.

Inne i metoden kan vi nu bestdmma vad som ska hénda nér en anvindare klickar pa en rad i listan.
Enklast just nu ar forstas att bara logga till LogCat.



Nér du nu kor din app igen, s& bor LogCat visa din text nar man trycker pa en post i listan.

Uppgift: Implentera onListItemClick och skriv ut ndgon text genom LogCat for att se att interak-
tionen med listan funkar korrekt.

4.4 Visa en popup

Nu nér vi vet att det funkar att klicka pa en post i listan, sa kanske det kan vara roligare att fa
upp ett meddelande i appen istéllet for LogCat.

Tidigare sdg vi att man enkelt kunde utforma sitt grafiska grénssnitt med den grafiska editorn.
Det kan man anvédnda for mer eller mindre allt grafiskt arbete, men nér det kommer till enklare
saker som tex dialogrutor kan det vara lampligt att skriva dem direkt i koden.

For att gora detta anviander vi oss av en Builder till komponenten AlertDialog. AlertDialog visar
en popup-dialog anpassad for saker som att bekrifta en atergérd eller visa information om en post.

AlertDialog.Builder builder = new AlertDialog.Builder(this);

Vi kan nu lagga till saker i varan builder. Anropa metoden setMessage med en string som argument
for att sdtta ett textmeddelande som dyker upp ndr man klickar pa en post.

Vi har &nnu inte skapat varan AlertDialog, men det gér vi nu genom att anropa
AlertDialog dialog = builder.create();

Vi kan visa dialogrutan genom dialog.show();

Kor appen och se hur du nu far en popup ruta med texten nir du klickar pa en post!

Uppgift: Anvind dig av AlertDialog och dess tillhérande Builder for att skapa en dialogruta som
visas nir man klickar pa en post i listan.

5 Ta bort poster

Lat oss nu forsoka ldagga till funktionalitet for att kunna ta bort en post ifran listan. Metoderna
setPositiveButton och setNegativeButton pa builder-objektet ger tillgdng till tva knappar som man
kan styra hur man vill. Bada tva metoderna tar tva argument; en string for texten pa knappen och
en OnClickListener. Héar kan du antingen anropa en lyssnare som du skapat nagon annanstans,
eller helt enkelt skapa den direkt i metodanropet genom

new DialogInterface.OnClickListener() { }

Inuti denna lyssnare sa maste metoden onClick(DialogInterface, int) finnas. Det ar alltsa hér inne
som funktionaliteten for att kunna ta bort en post ifran listan skall implementeras.

For att ta bort en post ifrdn listan sa behéver du anropa metoden remove pa adapter. remove tar
i det har fallet ett objekt av typen String som argument, da ArrayAdapter:n har blivit deklarerad
for att hantera just String. Hé&r vill du nu plocka bort den aktuella posten i listan genom att hitta
den i testData. I argumenten for onListltemClick sa finns den aktuella postens index i konstanten



id.
Om du gjort réitt sd kommer posten tas bort fran bade testData och adapter, vilket kommer resul-
tera i att listan i det grafiska grénssnittet uppdateras korrekt.

Knappen fér “Ok” behéver inte géra nagonting, sa hela onClick-metoden kan bara vara tom.
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Figure 2: AlertDialog med mojlighet att ta bort den aktuella posten i listan.

Uppgift: Skapa tva knappar i dialogrutan, en som bara ar “Ok” och inte gér nagot mer &n att
stanga rutan, och en “Delete” som tar bort den aktuella posten fran listan.

5.1 Knappar och textfalt

Det hade naturligtvis varit trevligt med mojligheten att lagga till nya poster i listan. For att gora
det behéver vi en knapp for att 1dgga till, och ett textfilt for att skriva in namnet.

Ga tillbaka till ditt grafiska gréanssnitt (activity_main.zml).

Léagg nu till ett textfalt (“Text Fields -> Plain Text”) genom att dra och slédppa. Ligg det sa att
tva textrutor dyker upp dér det star “alignParentLeft” och “alignParentTop”. Légg sedan till en
knapp (“Widgets -> Button”). Placera knappen sa att liknande rutor dyker upp, som séger “align-
ParentTop” och “alignParentRight”. Justera nu storlekarna pa bade textfiltet och knappen, sé att
textfiltet far rutan “toLeftOf=button0” eller motsvarande, och knappen “above=Q@android:id /list”.
Till sist, justera storleken pa listan s& att rutan “below=editText0” eller liknande dyker upp.

M o< Of-add

Figure 3: Rutor som dyker upp da “views” flyttas och &ndrar storlek.

Nu har vi skapat en layout dar objektens storlek och position &r beroende av varandra. Detta ar
givetvis inget krav, men skapar tydliga linjer i grénssnittet, vilket far det att se mindre rorigt ut.
Ge dem ett lampligt id i Properties, tex “add” fér knappen och “name” for textfiltet. Detta &r



oftast enklast att dndra i “text”-ldget. Kom ihag att det maste vara pa formen @+id/ditt-namn-hdr.

Item 1

Figure 4: Elementens positions- och storleksberoenden.

For att gora det lite ldttare for anvindaren att hitta textfiltet kan det vara bra att lagga till en
sa kallan hint. Gor det genom att markera textrutan i den grafiska editorn, och leta sedan upp
filtet “hint” i “properties”-panelen. Skriv nigot lampligt! Andra texten i knappen pa liknande
satt, genom att fordndra faltet “text”.

Om du testkor din app nu, sa bor du se bade knappen och textféiltet som det ser ut nér du designar
ditt grafiska grénssnitt, men de gor inget &n sa lat oss fixa det.

For att kunna interagera med knappen sa behover vi ladgga till lyssnare. Detta gor vi i onCreate-
metoden. Skapa forst knappen genom:

Button button = (Button)findViewById(R.id.add) ;

Dvs, om knappens id &r satt som “add”. Nu kan vi anropa metoden setOnClickListener pa button.
Som tidigare kan vi skapa en lyssnare direkt i metodanropet

new View.OnClickListener() { }

Som tidigare behovs en 6verlagrad metod onClick(View) i lyssnaren (av typen public void). Innan
vi kan definera vad knappen ska gbra nir anvindaren trycker pa den, sa maste vi identifiera att
anvandaren har tryckt just pad varan knapp. I onClick sa har vi fatt med en View som har den
tillhérande metoden getld() for att hdmta id pa det elementet som har aktivierats. Se till sa att
det Gverensstdmmer med id pa varan knapp genom att jamféra med R.id.add.

Nu maste vi hdmta ut informationen som ar inskrivet i textfaltet! P& samma sdtt som knappen
skapades ovan sa kan vi skapa ett textfilt, som ar av typen EditText istéllet for Button. Metoden
getText() hamtar ut text fran ett textfalt, dock ar det inte av typen String. Fixa det! Hint: Vanligt
sitt att gora om till String som anvénts i tidigare kurs om Java.

Sen ar det bara att lagga in texten i form av en String i adapter. Det ar véldigt likt det vi gjorde
tidigare nér vi tog bort elementet ur adapter...

Uppgift: Skapa en knapp och ett textfdlt. Nar man trycker pa knappen skall texten som &r i
textfiltet laggas till i listan.

6 Databaskoppling

Hittills har vi endast lagrat data i en ArrayList. Den tas naturligtvis bort sa fort programmet
stdngs ned. Ett smidigare sétt att lagra data fér en Todo-lista dr att lagra allt i en liten SQL-
databas. All kod for att skapa en databas och lagra en egen klass i den ar redan skriven, och finns



i filerna MySQLiteHelper.java, TodosDataSource.java och Todo.java.

Har ar ett bra stélle att klippa navelstréngen, nedan ges bara de metoderna som kan vara anvand-
bara for att fa det att funka med databasen. Allt dr redan fardigt i de filerna som skickas med sa
inget behdver dndras dér, men lds igenom dem for att forsta hur det hdnger ihop. Forstk komma
s& langt ni kan!

Datamedlemmar: ArrayList av typen Todo, ArrayAdapter av typen Todo, TodosDataSource
TodosDataSource metoder: open(), getAllTodos(), createTodo(), deleteTodo()

Uppgift: Skapa en Todo-app med koppling till en databas.

Lycka till!



